
MassHunter Mass Profiler Software
Quick Start Guide
Getting Started    8
 How do I get started?    8
 Terminology    9
 Processing and viewing results    10
 Identification    11
 Exporting data    12
User Interface    13
 Main functional areas    13
 Menu bar    18
 Toolbar    29
 Feature Table    30
 Feature Plot    33
 Feature Details    36
 Shortcut menu commands    39
Mass Profiler Installation    44

What is Mass Profiler?
Agilent MassHunter Mass Profiler software is a stand-alone program 
specifically designed to investigate features in your LC/MS sample data files 
and compare feature similarities and differences in your data between two 
samples, within a single sample group, or between two samples groups. The 
feature investigation capabilities are well suited for the comparison of two 
samples from different environmental locations (for example, two locations in 
a river or a ground water well) and different batches in a food or chemical 
synthesis process. Mass Profiler can also be used for expression profiling 
applications such as biomarker discovery. Mass Profiler uses a unique feature 
extraction and correlation algorithm that locates and aligns all the 
components in even the most complex sample mixtures. 



What is Mass Profiler?
Mass Profiler helps you:

• Find and extract the features in your sample data.

• Align and normalize features from different samples.

• Review the features in your samples individually and by grouping.

• Investigate similarities and differences in features across two samples, a 
single sample, or two sample groups.

• Conduct a sample classification in pairs using Principal Component 
Analysis. 

• Identify features via a molecular formula generator or accurate mass 
database search using MassHunter ID Browser.

Mass Profiler operates on raw data files and compound exchange files 
produced by MassHunter Qualitative Analysis and Profinder on LC/MS data 
files. Retention time, mass, and abundance LC/MS data can also be imported 
from any source using comma separated value files. GC/MS data files 
currently are not supported

Feature extraction, combined with chromatographic alignment across 
multiple data files, is a critical step in the peak finding and data reduction 
workflow that minimizes the appearance of both false positive and false 
negative features by “binning” the features in the chromatographic time 
domain. 

When used to export features, Mass Profiler reduces your acquired data size 
and complexity, yielding a smaller data set that is more easily processed 
without any compromise in the information quality.

The feature files generated by Mass Profiler can be imported into Mass Profiler 
Professional (MPP), a powerful chemometrics platform used in any MS-based 
differential analysis to determine relationships among two or more sample 
groups and variables.
2 Mass Profiler Quick Start Guide



What’s new in B.07.00?
What’s new in B.07.00?
• Projects can be created from raw MassHunter data files and directly extract 

features using Find Compounds by Molecular Feature (also referred to as 
Molecular Feature Extractor, MFE), allowing an entire profiling workflow to 
be conducted in Mass Profiler.

• MFE employs recursive grouping of ions across multiple data files to 
minimize false positive and false negative features. 

• Added flexibility added for specifying how MFE finds related ions with 
different charge carriers and which charge carrier to assign for 
single-species ions.

• Post-alignment filtering is available based on quality score (Q-Score) or 
abundance. Q-Score is a new attribute that when used for filtering features 
provides an advantage over abundance filtering when features have small 
abundances.

• Feature Details view provides the ability to view extracted ion 
chromatograms (EIC) from all or individual ions associated with a feature 
and to view the averaged mass spectra across a feature elution.

• Streamlined Method Editor dialog box with two editing modes: only 
commonly changed parameters and all method parameters.

• Saving a project automatically includes an embedded copy of the method 
used to create the last results. You can also save methods separately. 
Additionally, Mass Profiler internally retains the current method 
parameters on exiting, whether or not the method was saved to disk.

• Principal Component Analysis (PCA) is available.

• Identify features using ID Browser B.07.00.
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Features of Mass Profiler
Features of Mass Profiler
• Unique feature extraction and correlation algorithm locates the molecular 

features in your data files, not just chromatographic peaks.

• Visualization tools help you identify statistically meaningful differences 
between two sample groups, such as healthy versus disease samples.

• Calculate abundance ratios and clearly identifies differentially expressed 
features.

• Flexible feature selection to selectively analyze and compare your data.

• Export compound information for import into database search programs, 
identification environments, non-MassHunter statistical analysis packages, 
and advanced statistical data analysis by Mass Profiler Professional 
software.

• Supports data analysis workflows including metabolomics, integrated 
biology, pharmaceutical impurity analysis, forensic analysis, environmental 
analysis, and pesticide analysis.

• Open all or some of the files associated with your Agilent data set (sample 
files) in a single selection process.

• Create methods for your feature extraction, chromatographic alignment, 
and differential analysis, and save them to disk as a Mass Profiler Method 
file (.mpm).

• Review your features and chromatographic alignment using an intuitive 
graphical interface.

• Delete false positive features from your results.

• Save your feature extraction and feature review progress as a Mass Profiler 
project file (.pjt) and open the project at a later time to review, adjust, and 
reprocess your data files.
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Where is Mass Profiler used in your experiment?
Where is Mass Profiler used in your experiment?
Mass Profiler is used to extract and/or review the features from LC/MS data 
files you acquired from your experimental samples. An untargeted differential 
analysis experiment may include the steps as shown below.

1 Prepare for your experiment

2 Acquire your data - Data Acquisition

3 Extract spectral features in your data files - Mass Profiler, Profinder, or 
Qualitative Analysis/DA Reprocessor

4 Compare two samples or sample groups - Mass Profiler

5 Identify features in your data - ID Browser in Mass Profiler

6 Export features for advanced statistical analysis - MPP

7 Save your project - Mass Profiler and MPP

Figure 1 Feature extraction performed by the MFE algorithm in Mass Profiler is similar 
to the MFE algorithm in MassHunter Qualitative Analysis/DA Reprocessor or 
Profinder; however, Mass Profiler and Profinder add the functionality of recur-
sive grouping across multiple data files.
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Where to find more information
Figure 1 shows the steps and MassHunter tools that are used in an untargeted 
and targeted (Profinder and Qualitative Analysis) differential analysis. The 
feature finding steps performed by Mass Profiler can alternatively be 
accomplished in Qualitative Analysis/DA Reprocessor or Profinder (TOF and 
Q-TOF data) as described in the Class Prediction with Agilent Mass Profiler 
Professional - Workflow Guide.

Mass Profiler provides easy to use data analysis capabilities to help you review 
features, compare features between two samples or sample groups, and a 
perform a principal component analysis with your samples organized into two 
groups. Compared to MPP, Mass Profiler is unique in that you can view 
compound chromatograms and spectra during your analysis.

Where to find more information

Online Help

Press F1 To get more information about a pane, window, or dialog box, place 
the cursor on the pane, window, or dialog box of interest and press F1.

Help Menu Click Help > Contents to access the contents of the Mass Profiler 
Help including basic tasks, user interface, and reference information.

Documents

Mass Profiler Familiarization Guide Use this guide to learn 
how to use Mass Profiler. This guide can be found on the 
installation disc and also online at 
http://www.chem.agilent.com/Library/usermanuals/Public/
G3297-90012_MassProfiler_Familiarization.pdf.

Mass Profiler Professional 
• Agilent G3835AA MassHunter Mass Profiler Professional Software - Quick 

Start Guide

• Agilent G3835AA MassHunter Mass Profiler Professional Software - 
Familiarization Guide

• Agilent G3835AA MassHunter Mass Profiler Professional Software - 
Application Guide
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Where to find more information
• Agilent MassHunter Mass Profiler Professional User Manual

Workflow Guides and Overviews 
• Agilent Metabolomics Workflow - Discovery Workflow Guide (p/n 

5990-7067EN)

• Agilent Metabolomics Workflow - Discovery Workflow Overview (p/n 
5990-7068EN)

• Integrated Biology with Agilent Mass Profiler Professional - Workflow 
Guide (p/n 5991-1909EN)

• Integrated Biology with Agilent Mass Profiler Professional - Workflow 
Guide Overview (p/n 5991-1910EN)

• Class Prediction with Agilent Mass Profiler Professional Workflow Guide 
(p/n 5991-1911EN)

• Class Prediction with Agilent Mass Profiler Professional Workflow 
Overview (p/n 5991-1912EN)

MassHunter Qualitative and Quantitative Analysis 
• Agilent MassHunter Workstation Software Qualitative Analysis 

Familiarization Guide for LC/MS

• Agilent MassHunter Workstation Software Qualitative Analysis 
Familiarization Guide for GC/MS

• Agilent MassHunter Workstation Software Quantitative Analysis 
Familiarization Guide

Training

Road Show Slide Presentation Metabolome Analysis - From Sample Prep 
Through Data Analysis (Metabolomics Road Show, March 2011)

Training Courses  Visit www.chem.agilent.com to view a listing of training 
courses for Mass Profiler.
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Getting Started
How do I get started?
Getting Started

How do I get started?
This Quick Start Guide helps you install Mass Profiler, become familiar with 
the Mass Profiler user interface, perform feature extraction, and perform a 
two sample or two sample group comparison using your data.

1 Install Mass Profiler. Follow the instructions in “Mass Profiler Installation” 
on page 44.

2 Start Mass Profiler. Double-click the Mass Profinder icon  located on 
your desktop or in the Agilent MassHunter Workstation desktop folder, or 
click Start > All Programs > Agilent > MassHunter Workstation > Mass 
Profiler > Mass Profiler.

3 Review this Quick Start Guide to learn about:

• Getting Started

• User Interface

4 Review the Familiarization Guide to learn how to:

• Process Data

• View Results

• Identify Features

• Export Data

5 Review the “MassHunter Qualitative and Quantitative Analysis” guides (see 
“Documents” on page 6). These guides help you improve your results by 
covering topics that help you:

• Prepare for an experiment

• Explain the parameters related to finding features

• Compare two samples or sample groups

6 Review the Familiarization Guide to learn how to extract the features in 
your samples. Follow the example Basic Mass Profiler Workflow in 
“Exercise B: 2-Sample-Group-Comparison”.
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Getting Started
Terminology
Terminology
Algorithm An algorithm is a set of automated, sequential mathematical tasks performed 

to find, filter, align, extract, compare, and identify features from your 
chromatographic/ mass spectral data sets.

Feature A feature is synonymous with compound. A feature is referred to 
interchangeably with compound, descriptor, element, entity, metabolite, or 
molecular feature during the various steps of analysis using MassHunter 
software. A feature can consist of one or multiple related ions, including 
isotopes, and different ion species (charge carrier, multimers) and charge 
states.

Group Samples that have a common relationship within the definition of the 
experiment design, for example, samples from a group of healthy versus 
diseased specimen. Related samples are grouped together for analysis. For a 
project with two groups, Mass Profiler initially assigns “Experiment” and 
“Control” for the group names. These default names can be changed.

Method A method is a set of all the parameters used for processing sample files in a 
Mass Profiler project, including feature finding, aligning, normalizing, and 
filtering. Methods can be saved using unique file names.

Project Two samples, or one or two sample groups, and the associated method that 
form your feature analysis and investigation. A project can be saved and 
opened at a later time to continue your analysis. 

Sample LC/MS data acquired from a specimen and understood to be representative of 
the larger specimen or population. Individual samples are imported into Mass 
Profiler in the form of raw data files, CEF files, or CSV files (see Figure 1 on 
page 5).

NOTE The data file path is saved with the project. If you move a project to a different computer, 
you can open the project and see the results. But to access the Feature Details, the data 
files on the target computer must be in the same path as on the source computer. If they 
are not, Mass Profiler cannot find the *.rmc file for the first data file it tries to access, and 
you get an error message. The *.rmc files are stored in the data file. The error message 
indicates the path where the data files are expected to be found.
Reprocessing the project with different method parameters also fails if the data files are 
not found in the path that is saved with the project.
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Getting Started
Processing and viewing results
Workflow A workflow is a document or a graphical overview that captures a sequence of 
steps to guide you through an analytical task. A workflow may cover more 
than one wizard and may include steps performed by more than one 
MassHunter software program.

Processing and viewing results
The results of processing samples appear in the Feature Table, Feature Plot 
and Feature Details in the main window. In the main window you select 
whether to show the Feature Plot or the Feature Details to appear with the 
Feature Table in the main window (see Figure 3 on page 13 and Figure 4 on 
page 14).

Use the Feature 
Table to:

• View all of the feature information for two samples or represented 
statistically across one or two groups.

• View feature information in four sections showing information across all 
samples, each of the two sample groups, and comparison of two sample 
groups.

• Mark and unmark features for identification and PCA analysis.

See “Feature Table” on page 30 for more information.

Use the Feature 
Plot to:

• Visualize and investigate features using different plot types: Mass vs. 
Retention Time, Log2 Ratio vs. Retention Time, Log/Log Abundance, Unique 
to <Group 1>, and Unique to <Group 2>, the latter two are available with 
projects containing two groups.

• Investigate features in individual or multiple samples.

• Investigate features that exceed a specified visibility threshold filter setting.

• Investigate features by mass and retention time across all samples or use 
color to distinguish individual features or to identify features by sample or 
group.

See “Feature Plot” on page 33 for more information.

Use the Feature 
Details to:

• Visualize and investigate specific individual feature details such as 
appearance in each sample file, appearance in each group, and the ion 
species within the feature.

• Compare the feature’s appearance across all of the samples.
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Getting Started
Identification
• Investigate features by retention time, mass, and m/z using extracted ion 
chromatograms and mass spectra for all of the samples.

See “Feature Details” on page 36 for more information.

Identification
Mass Profiler (Figure 2.) helps you identify features via Molecular Formula 
Generation or an accurate mass database search (a .cdb or .csv formated 
database) using MassHunter ID Browser. Features can be identified 
individually or in a batch. Additional mass-based identification methods are 
supported using publicly available database searches. Spectral library search 
is not supported in ID Browser for LC/MS data.

Figure 2 ID Browser after identifying features as compounds
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Getting Started
Exporting data
Exporting data
Features found and aligned across samples form “composite features” and can 
be exported in several formats for different purposes. You can export features 
in the following formats:

• .cef - Export file format that contains a list of the found features in each 
sample with the algorithm used to find the features, and includes MS ions 
(only precursor ions) with mass, abundance, RT, charge state, and charge 
carrier. A compound exchange format (CEF) file is created to exchange data 
between Agilent software. CEF files are typically used for import into MPP 
for advanced statistical analysis.

• .csv - Averaged ion data (m/z and RT of representative ions) for each feature 
for use in data acquisition in targeted MS/MS experiments. An ASCII text 
comma separated value (CSV) file is created containing specific feature 
information that can be readily imported into acquisition software as an 
MS/MS inclusion list or imported into text editors and spreadsheets.

• .txt - Feature data for use in Mass Profiler Professional. A tab delimited 
ASCII text (TXT) file is created containing the feature information for each 
sample data file that is readily imported into MPP, other data analysis 
software, text editors, and spreadsheets.

• .xls - Feature Summary data for use in Excel. This format is the same tab 
delimited ASCII text file as the .txt format, but the .xls extension allows the 
data to be readily imported into Microsoft Excel. The file can also be 
imported into text editors.
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User Interface
Main functional areas
User Interface

Main functional areas
The main Mass Profiler window consists of three parts: (1) the Menu Bar, (2) 
the Toolbar, and (3) the Main Window. The main functional areas are shown in 
Figure 3.

Figure 3 The main functional areas of Mass Profiler after a method is run on a project. If selected in the View 
menu, the Feature Plot can be replaced with a Features Details view shown in Figure 4 on page 14.
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User Interface
Main functional areas
1. Menu Bar

The menu bar provides actions that are used for managing your projects, 
methods, display, and identifying features.

2. Toolbar
The toolbar is located below the menu bar and contains three groups of 
buttons for commonly used tasks:

Project: Create Project, Open Project, and Save project

Method: Load and Open Method, Edit Method, and Save Method.

Figure 4 When you click View > Show Feature Details from the menu, the Feature Details view replaces the 
Feature Plot view in the main window shown in Figure 3 on page 13.
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User Interface
Main functional areas
ID & Run: Identify All Features (opens and runs ID Browser) and Run Current 
Method.

3. Main Window

The main window, see Figure 3 on page 13, is further divided into two areas — 
Feature Table and Feature Plot that are used to review the results from 
applying the feature extraction, alignment, filtering, and comparison defined 
in the method to your data set.

Feature Table The data presented in Feature Table is organized by four 
sections: (1) Feature Summary with ID, (2) Experiment (group) information, 
(3) Control (group) information, and (4) Comparison information as shown in 
Figure 5. Each feature is presented in a row and information related to each 
section is presented in a column.

Figure 5 Data areas within the Feature Table

Feature information is presented as the average across all of the samples in a 
single group project. When your project contains two groups the Feature 
Summary columns report the average mass and RT, but the higher (averaged) 
abundance and Q-Score across both groups, as well as standard deviations and 
relative standard deviations. One column indicates if there was saturation in 
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User Interface
Main functional areas
the compound spectrum, and another column allows you to mark features for 
additional tasks such as identification, PCA calculation, or exporting. The 
columns in the Comparison section report the mass and RT differences 
between groups, the intensity ratio, up- or down-regulation, and differential 
score.

When you right-click the row number within the Feature Table you have 
additional options to review and identify the individual feature.

Feature Plot The data presented in Feature Plot is organized as a set of 
graphical data that help you view the distribution of the features in mass 
versus retention time (RT) axes (see Figure 6). The relative size of the marker 
representing a feature is an indication of the average abundance of the feature.

Figure 6 Views available within the Feature Plot

The two additional graphs designed to compare abundance ratios between 
groups are not informative with a single group project. However, when your 
project contains two groups the additional to graphs help you visualize the 
abundance ratios with respect to retention time and mass and help you 
visualize the features with respect to group membership.

When you click within the Feature Plot you can zoom in on the mass and 
retention time axes to see more of the feature detail.

When you right-click within a Feature Plot you have additional options to 
unzoom, review and identify the feature, and print, copy and save the 
graphical information. When you right-click along the axes or border of a 
Feature Plot you have options to unzoom, print, copy and save the graphical 
information.
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User Interface
Main functional areas
When you move the pointer over a feature in the plot, a data window shows 
details about the feature, including mass, RT, and abundance, including 
absolute and relative standard deviation values across a group.

Feature Details The data presented in Feature Details is organized in four 
panes: (1) Feature Details by Sample - a table of the feature appearance in 
each sample data file, (2) Feature Details by Ion, (3) Extracted Ion 
Chromatogram graphics, and (4) Average Mass Spectrum graphics. The 
graphics can be arranged by group as shown in Figure 7, or by sample. The 
chromatogram and spectrum graphics are available if the method was run on 
raw data files.

Figure 7 Data areas within the Feature Details

Information available in the Feature Details is limited for file types other than 
raw data files. For CEF files extracted ion chromatograms are not available. 
For CSV files Feature Details are not available.

When you double click on any row number the information displayed updates 
to reflect to the current feature. When you click within any chromatogram or 
spectrum you can zoom in on the axes of the entire data set to see more of the 
feature detail.

When you right-click within any chromatogram or spectrum you have 
additional options to print, copy and save the graphical information. 
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User Interface
Menu bar
Menu bar
The following menu items are available in Mass Profiler:

• “File menu”

• “Method menu” on page 21

• “View menu” on page 23

• “Identify Features menu” on page 25

• “Web Search menu” on page 27

• “Help menu” on page 28

File menu

Create Project Opens the Create Project dialog box that you use to begin new 
project. See “Create a project” in the Familiarization Guide.

Open Project Loads a previously saved project into the main window. 
Because Open Project also loads the method used to create the results saved 
in the project, if you have unsaved changes in your current method a dialog 
box prompts you to save your current method before the Open dialog box is 
opened.

Edit Project Opens the Edit Project dialog box where you can edit the current 
project. See “Edit a project” in the Familiarization Guide.
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User Interface
Menu bar
Save Project Saves changes to the current project using the Project name 
previously entered in the Create Project dialog box. The default folder is 
\MassHunter\MassProfiler\Projects.

Save Project As Opens the Save Project As dialog box so you can save the 
current project using a different name. You can also specify a different folder 
to save the project.

Export Feature Summary > From Table... Opens the Save As dialog box to 
export the feature summary information from the Feature Table for use in a 
spreadsheet. The export file format is tab-separated value (TSV) and can 
opened in a text editor, but it is saved as an XLS file so that Excel opens the 
file automatically when you double-click on the file in Windows Explorer. You 
can export from the Feature Table using one of three options:

• From Table - All Features

• From Table - Marked Features

• From Table - Unmarked Features

If you have marked features from a principal component analysis a PCA Mark 
column is added to the Feature Table and two additional options are available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features

Export Feature Summary > From Graphed Features The features that meet the 
parameters you select and specify in the Plot mode are displayed in the 
Feature Plot. This menu item opens the Save As dialog box to export the 
features in the current Feature Plot for use in a spreadsheet. The export file 
format is TSV and can opened in a text editor, but it is saved as an XLS file so 
that Excel opens the file automatically when you double-click on the file in 
Windows Explorer.

Export Target MS/MS Inclusion List > From Table... Opens the Export 
Inclusion List Options dialog box where you specify filter parameters for 
exporting the averaged ion data (m/z, z, RT, delta RT) for each feature in the 
Feature Table for use in data acquisition in targeted MS/MS experiments. The 
export file format is CSV. You can export from the Feature Table using one of 
three options:

• From Table - All Features

• From Table - Marked Features
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User Interface
Menu bar
• From Table - Unmarked Features

If you have marked features from a principal component analysis a PCA 
Mark column is added to the Feature Table and two additional options are 
available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features

Export Target MS/MS Inclusion List > From Graphed Features 
The features that meet the parameters you select and specify in the Plot mode 
are displayed in the Feature Plot. This menu item opens the Export Inclusion 
List Options dialog box where you specify filter parameters for exporting the 
averaged ion data (m/z, z, RT, delta RT) for each feature in the Feature Table 
for use in data acquisition in targeted MS/MS experiments. The export file 
format is CSV. 

Export MPP Input File > From Table... Opens the Save As dialog box to export 
the feature summary information from the Feature Table for use with MPP. 
The export file format is a tab-delimited text file. You have a choice to export 
with a .txt extension for opening in a text editor, or an .xls extension for direct 
opening in Excel. You can export from the Feature Table using one of three 
options:

• From Table - All Features

• From Table - Marked Features

• From Table - Unmarked Features

If you have marked features from a principal component analysis a PCA Mark 
column is added to the Feature Table and two additional options are available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features

Export MPP Input File > From Graphed Features The features that meet the 
parameters you select and specify in the Plot mode are displayed in the 
Feature Plot. This menu item opens the Save As dialog box to export the 
features in the current Feature Plot for use in MPP. The export file format is a 
tab-delimited text file. You have a choice to export with a .txt extension for 
opening in a text editor, or an .xls extension for direct opening in Excel. 
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User Interface
Menu bar
Export Composite-Compounds CEF > From Table... Opens the Save As dialog 
box to export the feature summary information from the Feature Table for use 
with MPP for advanced statistical analysis. The export file format is a CEF file. 
The features within a group are summed to form a composite compound. You 
can export from the Feature Table using one of three options:

• From Table - All Features

• From Table - Marked Features

• From Table - Unmarked Features

If you have marked features from a principal component analysis a PCA 
Mark column is added to the Feature Table and two additional options are 
available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features

Export Composite-Compounds CEF > From Graphed Features The features that 
meet the parameters you select and specify in the Plot mode are displayed in 
the Feature Plot. This menu item opens the Save As dialog box to export the 
features in the current Feature Plot for use with MPP for advanced statistical 
analysis. The export file format is a CEF file. The features within a group are 
summed to form a composite compound. 

Exit Closes the Mass Profiler window and exits the program. 

Method menu

Parameters specified in a method define how to extract, align, normalize, 
filter, and compare the features found in your sample data files. When the 
method is run the results are displayed in the Feature Table and Feature Plot 
in the main window. 
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User Interface
Menu bar
Run Current Method Applies the current method parameters to your project. 
Prior results are replaced and the new results are displayed in the main 
window.

Edit Method Opens the Method Parameters dialog box. When the Commonly 
changed parameters option is selected (default setting), located at the bottom 
of the dialog box, typical parameters are available to review and edit. When 
the All parameters option is selected all of the method parameters are edited 
within three tabs: Feature Finding/Loading, Filters, Alignment & 
Normalization, and Statistics & Filters. See “Edit a method” in the 
Familiarization Guide. When you change parameters in a method, the 
method name in the window title indicates an unsaved change using an 
asterisk (*).

Save Method Saves changes to the current method.

Save Method As Opens the Save Method As dialog box saves the current 
method parameters in the folder you select and using a name you type for the 
File name with the extension .mpm.

Load and Open Method Opens the Open dialog box. After you select and open 
a saved method the Method Parameters dialog box is automatically opened 
for you to review and edit the method parameters. See “Apply a different 
method” in the Familiarization Guide.

Load Method and Run Opens the Open dialog box. After you select and open a 
saved method the method is automatically applied to your current project. See 
“Apply a different method” in the Familiarization Guide.

Reset Method to Default Immediately restores all method parameters to 
default values. If your method has unsaved changes a Mass Profiler dialog box 
allows you to save your current method or cancel the reset action. The window 
title displays “Method: Default Method.”
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User Interface
Menu bar
View menu

Show Feature Details If a Feature Plot is displayed in the main window, this 
menu item is available instead of Show Feature Plot. Replaces the Feature 
Plot view in the main window with details of the feature selected in the 
Feature Table as shown in Figure 4 on page 14.

Show Feature Plot If Feature Details is displayed in the main window, this 
menu item is available instead of Show Feature Details. Replaces the Feature 
Details view in the main window with the Feature Plot as shown in Figure 3 on 
page 13.

Feature Details for Selected Feature If a Feature Plot is displayed in the main 
window, a new window labeled FeatureDetailFrame opens and displays 
details of the feature selected in the Feature Table. If Feature Details is 
displayed in the main window, the Feature Details information is updated to 
show the details of the feature selected in the Feature Table. See “View results 
in the Feature Details” in the Familiarization Guide. 

Abundance Distribution for Selected Feature Opens the Abundance 
Distribution of Feature # window and displays the abundance profile of the 
feature and a histogram of abundances for the feature within each group. For 
two groups the curves are color-coded for the group. The curves are calculated 
by using the least-squared fit to a Gaussian shape. See “View the feature 
abundance distribution” in the Familiarization Guide.
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User Interface
Menu bar
Global Occurrence Histograms Displays histograms that show how frequently 
a feature occurs in samples within each group and across the total set of data 
files. See “View the global occurrence histograms” in the Familiarization 
Guide.

Principal Component Analysis > ... Displays the results of performing a 
mathematical process by which data containing a number of potentially 
correlated variables is transformed into a data set in relation to a smaller 
number of variables called principal components which account for the most 
variability in the data. The result of the data transformation leads to the 
identification of the best explanation of the variance in the data. For a project 
with two groups the objective to identify whether variations among the 
features separate the samples by group. For a project with a single group the 
analysis can identify samples that may be outliers.
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You can export from the Feature Table using one of options:

• For All Features in Table

• For Marked Features in Table

• For Unmarked Features in Table

• For Highlighted Features on Graph - The features that meet the 
parameters you select and specify in the Plot mode as displayed in the 
Feature Plot.

If you have marked features from a principal component analysis a PCA Mark 
column is added to the Feature Table and two additional options are available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features

Identify Features menu
For each of the menu selections ID Browser is opened with the selected 
feature(s) for identification. See “Identify Features” in the Familiarization 
Guide for more information. 

Note: Identify Features does not apply to data imported from a CSV file or 
from a CEF file with LMFE results.
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For All Features in Table All of the features in the Feature Table are passed to 
ID Browser for identification. The results saved in ID Browser are 
automatically added to the Feature Table after you close the ID Browser 
window.

For Marked Features in Table The features marked in the Mark column in the 
Feature Table are passed to ID Browser for identification. The results saved in 
ID Browser are automatically added to the Feature Table after you close the ID 
Browser window.

For Unmarked Features in Table The features that are not marked in the Mark 
column in the Feature Table are passed to ID Browser for identification. The 
results saved in ID Browser are automatically added to the Feature Table after 
you close the ID Browser window.

For Highlighted Features on Graph The features that meet the parameters you 
select and specify in the Plot mode are displayed in the Feature Plot and are 
passed to ID Browser for identification. The results saved in ID Browser are 
automatically added to the Feature Table after you close the ID Browser 
window.

Quick Lookup for Selected Feature The feature currently selected in the 
Feature Table (the feature with a ►in the row header indicating the table row 
number) is passed to ID Browser for identification. The results viewed in ID 
Browser are not added to the Feature Table after you close the ID Browser 
window. See “Lookup the identity of a single feature” in the Familiarization 
Guide.

If you have marked features from a principal component analysis two 
additional options are available in the Identify Features menu. The PCA Mark 
column is only visible in the Feature Table if compounds have been marked in 
the PCA window.
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For PCA Marked Features in Table The features marked in the PCA Mark 
column in the Feature Table are passed to ID Browser for identification. The 
results saved in ID Browser are automatically added to the Feature Table after 
you close the ID Browser window.

For PCA Unmarked Features in Table The features that are not marked in the 
PCA Mark column in the Feature Table are passed to ID Browser for 
identification. The results saved in ID Browser are automatically added to the 
Feature Table after you close the ID Browser window.

Web Search menu
Performs a mass search via one of several popular online structure databases 
for the feature currently selected in the Feature Plot or Feature Table. The 
results are displayed in your Internet browser window.

ChemIDplus Mass search is directed to the NIH U.S. National Library of 
Medicine TOXNET toxicology data network at 
http://chem.sis.nlm.nih.gov/chemidplus.

HMP Mass search is directed to the Human Metabolome Project (HMP) 
Human Metabolome Database at 
http://www.hmdb.ca/structures/search/metabolites/mass.
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NIST Mass search is directed to the NIST Chemistry WebBook at 
http://webbook.nist.gov/chemistry/mw-ser.html.

PubChem Mass search is directed to the National Center for Biotechnology 
Information (NCBI) at 
http://www.ncbi.nlm.nih.gov/pccompound?TabCmd=Limits.

Web METLIN Mass search is directed to the Scripps Center for Metabolomics 
METLIN metabolite and tandem MS data base at 
http://metlin.scripps.edu/metabo_advanced.php.

Help menu

Contents Opens the online help window for Mass Profiler with the Contents 
tab displayed.

About Displays the version information for Mass Profiler.
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Toolbar
The following toolbar options are available in Mass Profiler. 

Button Equivalent menu item


File > Create Project


File > Open Project


File > Save Project


Method > Load and Open Method


Method > Edit Method


Method > Save Method


Identify Features > For All Features in Table


Method > Run Current Method
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Feature Table
The Feature Table (see Figure 3 on page 13) 
shows the results of processing the sample 
files selected in your project with the current 
method. Features are automatically displayed 
when you run the current method and when 
you open a project that has been previously 
processed. The table can be sorted by the 
values in any column by clicking on the 
corresponding column heading.

The following main headings and actions are presented:

• “Feature summary”

• “<Group 1> and <Group 2>” on page 32

• “Comparison” on page 32

• “Table shortcut actions” on page 33

Feature summary
Unless otherwise noted, the values reported for each column are the average 
of the feature across all of the samples.

(Row Number) The leftmost column, without a column heading, contains the 
row number for the features. The row number order does not change when the 
features are sorted by any of the data columns. A right-click in this column 
brings up the shortcut menu shown in Figure 8 on page 40.

Formula If you have identified features with ID Browser this additional 
column appears (see “Identify Features” in the Familiarization Guide).

Name If you have identified features with ID Browser this additional column 
appears (see “Identify Features” in the Familiarization Guide).

ID An identification (ID) number is assigned to each feature based in 
descending order of the values in the Abundance column. The Feature Table is 
initially sorted by the ID value, and therefore by composite feature abundance, 
but the sort order can be changed by clicking on the heading of any other 
column.
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RT Average retention time of the feature

RT SD Standard deviation of the retention time of the feature

Mass Average mass of the feature

Mass SD Standard deviation of the average mass of the feature 

Abundance Average abundance of the feature in all of the samples for in a 
single group. For a project with two groups the abundance value reported in 
the Feature Summary is the average across all of the samples in the group with 
the greatest average abundance.

RSD Relative standard deviation of the abundance of the feature

Freq. The number of samples that contain this feature

Q-Score The Quality Score is an algorithmic estimate of how likely the 
feature is an actual compound. Q-Score filtering provides an advantage over 
abundance filtering when the features have small abundances.

Sat. Feature abundance saturation is indicated in this column. Saturation is 
an indication that the relative abundance of the feature with respect to other 
features or between groups may not be reliable and the mass of the feature 
could be slightly shifted.

Mark The check boxes in this column are used to Mark one or more features 
of special interest to your project. The mark annotation is exported along with 
the other data in the table, so that the feature can still be distinguished when 
viewed in other programs. If you select a feature in error, click the check box 
again to clear the mark.

PCA Mark If you have marked features from a principal component analysis 
this additional column appears. You can only mark and clear features in this 
column from within the Principal Component Analysis dialog box, click one 
of the options under View > Principal Component Analysis (see “Perform a 
PCA analysis” in the Familiarization Guide).
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<Group 1> and <Group 2>
The values reported for each column are averages for the feature across the 
samples within the individual group only.

RT Average retention time of the feature

Mass Average mass of the feature

Abundance Average abundance of the feature

RSD Relative standard deviation of the abundance of the feature

Freq. The number of samples that contain this feature

Comparison
The values reported for each column are calculated between the average 
values of RT, mass and, abundance in <Group 1> and in <Group 2>.

RT The difference in the retention time of the feature between the groups 
(<Group 1> - <Group 2>)

Mass The difference in the mass of the feature between the groups (<Group 
1> - <Group 2>)

log2(A1/A2) The log base 2 of the ratio of the average feature abundance 
where A1 = <Group 1> and A2 = <Group 2>

Expression Indication of whether the average abundance of the feature in 
<Group 1> is greater (up) or lower (down) with respect to the average 
abundance of the feature in <Group 2>. When the equation log2(A1/A2) is 
greater than 0 the expression is reported as up-regulated. When the equation 
log2(A1/A2) is less than or equal to 0 the expression is reported 
down-regulated.

Diff. Score The differential score is a value between 0 and 100 that represents 
whether the data groups are significantly different. The score is calculated 
using the Student’s t-test. A larger value indicates a higher confidence that the 
data sets in the two groups are different.
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Table shortcut actions
See “Feature Table shortcut menu” on page 40 for options when you right-click 
on a plot.

Feature Plot
The Feature Plot shows a graphical result of 
processing the project with the current 
method. By adjusting the parameters above 
the tabs corresponding to the available plots 
you can adjust the plot to visualize the feature 
differences by sample and group. The Feature 
Plot is displayed automatically when you 
open a project or run a method. The relative 
size of the plot markers representing a feature 
is an indication of the average abundance of 
the feature: the larger the marker, the more 
abundant the feature.

The following sections and actions are 
presented:

• “Plot mode”

• “Graph data” on page 34

• “Colored by” on page 34

• “Visibility criterion and Visibility threshold” on page 34

• “Feature Plot tabs” on page 35

• “Plot mouse actions” on page 35

• “Plot shortcut actions” on page 36

Plot mode
Select whether to display the filtered features for all samples in monochrome 
or for a specific selection of sample files in color.

Avg. feature The plot displays the average abundance of the features that 
meet the Visibility criterion for all of the samples using monochrome 
markers.
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Indiv. samples The plot displays the average abundance of the features 
specified by the Graph data, highlighted by the Colored by and that meet the 
Visibility criterion using color. markers.

Graph data

When Indiv. samples is selected for the Plot mode you can select from any 
single sample or All samples to display in the plot.

Colored by

Feature Adjusts the plot so each feature is represented by a different color. 
When more features exist than can be plotted in different colors, features in 
the same area of the plot are plotted in different colors to help you distinguish 
the features.

Sample Adjusts the plot so features in the same sample are represented by 
the same color.

Group Adjusts the plot so features in the same group are represented by the 
same color: red represents <Group 1> and blue represents <Group 2>.

Visibility criterion and Visibility threshold

Allows you to filter the features based on criteria, whose threshold value 
determines which features appear as solid color markers in the plot. Features 
that exceed the threshold value are plotted as unfilled markers.

None All of the features are plotted using solid markers.

Max RSD abundance Features whose abundance relative standard deviation, 
within a group, is less than or equal to the entered threshold are plotted using 
solid markers.

SD RT Features whose retention time standard deviation, within a group, is 
less than or equal to the entered threshold are plotted using solid markers.

SD Mass Features whose mass standard deviation, within a group, is less 
than or equal to the entered threshold are plotted using solid markers.
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Differential Score Features whose differential score is less than or equal to 
the entered threshold are plotted using solid markers.

Feature Plot tabs

You can click any plot tab above Feature Plot to view a different plot type.

Mass vs. RT Plot of Mass versus retention time for each feature.

Log2 Ratio vs. RT Plot of the log base 2 of the ratio of the average feature 
abundance versus retention time.

• When Avg. feature is selected for the Plot mode, the abundance ratio is the 
average abundance for <Group 1> over the average abundance for <Group 
2>. 

• When Indiv. samples is selected for the Plot mode, the feature abundance 
ratio is the abundance for the feature in a a single sample over the average 
abundance of that feature in a group.

Log/Log Abund. Plot of the log2 of the average abundance of a feature: 

• When Avg. feature is selected for the Plot mode, the plot axes are log2 
<Group 1> versus log2 <Group 2>.

• When Indiv. samples is selected for the Plot mode, the plot axes are log2 of 
the feature in a single sample versus log2 of the average of that feature in a 
group.

Unique to <Group 1> Plot of mass versus retention time for each feature 
associated with <Group 1>. This plot type is not available for a project with a 
single group.

Unique to <Group 2> Plot of mass versus retention time for each feature 
associated with <Group 2>. This plot type is not available for a project with a 
single group.

Plot mouse actions
Zoom: Click and drag the pointer within the graph to define an area to enlarge. 
The area expands when you release the mouse button.

Marker information: Pass the pointer over a feature to view information about 
that feature.
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Plot shortcut actions
See “Feature Plot shortcut menu” on page 41 for options when you right-click 
on a plot.

Feature Details
The Feature Details (see Figure 4 on page 14) 
shows the details of the feature selected when 
you double click on the row number of a 
feature in Feature Table. The data presented 
in Feature Details is organized in four panes: 
a table of the feature appearance in each 
sample data file, a table of the feature ions in 
the selected sample data file, and, if available 
for the imported data type, extracted ion 
chromatograms and spectra of the feature for 
each sample data file.

Information available in the Feature Details is 
limited for file types other than raw data files. 
For CEF files extracted ion chromatograms 
are not available. For CSV files only the Feature by all samples pane is 
available.

The following sections and actions are presented:

• “Feature details by sample pane”

• “Feature details by ion pane” on page 37

• “Extracted ion chromatograms pane” on page 38

• “Spectra pane” on page 39

• “Feature Details shortcut actions” on page 39

Feature details by sample pane

The information in this table is for the feature selected in the “Feature Table” 
on page 30.

Samples that are part of the Experiment group are shown in a red color. 
Samples that are part of the Control group are shown in a blue color.
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(Row Number) The leftmost column, without a column heading, contains the 
row number for the features. The row number order does not change when the 
features are sorted by any of the data columns.

Smpl ID An identification (ID) number is assigned to each sample in the 
project ascending alphabetical order of the file name. The Feature Table is 
initially sorted by the Smpl ID value, but the sort order can be changed by 
clicking on the heading of any other column.

Sample Name The file name of the sample data file

RT Retention time of the feature in the sample file

Mass Mass of the feature in the sample file

Abundance Abundance of the feature in the sample file

Q-Score Quality score of the feature in the sample file. The quality score is an 
algorithmic estimate of how likely the feature is an actual compound. Q-Score 
filtering provides an advantage over abundance filtering when the features 
have small abundances.

# Peaks The number of ions associated with the feature in each sample. The 
number of ions is also annotated in the chromatogram titles after selecting 
Feature Details for a new feature in the Feature Table.

Feature details by ion pane
The information in this table is for the feature selected in the “Feature Table” 
on page 30, and for the sample selected in the Feature Details by Sample 
table above. This information is not available for the CSV file type.

The top row functions as a header row and reports the calculated neutral 
mass of the feature, and either reports the abundance of the most intense ion, 
if the abundances are reported as Height, or reports the sum of all ion 
abundances, if the abundances are reported as Volume. The header row is 
shown in a red color if the values for the ions are from a sample in the 
Experiment group. The header row is shown in a blue color if the values for 
the ions are from a sample in the Control group.
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Species The different molecular ion species associated with the feature in 
the selected sample file.

m/z The mass to charge ratio for each ion species.

Mass The neutral mass calculated for the feature based on the associated ion 
species.

Abundance The MFE abundance for the respective ion species reported as 
either Height or Volume, depending on the Report abundance as setting in 
the method.

Extracted ion chromatograms pane
This information is not available for CEF and CSV file types.

Double-clicking any row number in the Feature Details by Sample table, 
except the red or blue header row, updates the Feature Details by Ion table. 
By default all chromatograms are extracted using all ions associated with the 
selected feature. The number of ions is annotated in the chromatogram titles.

Double-clicking any row number in the Feature Details by Ion table updates 
the EICs to extract only the selected ion species and annotate its m/z value in 
the chromatogram titles.

The height of the chromatographic peak for all ions of a feature is similar, but 
not identical, to the sum of the Height abundances of the respective ions. The 
y-axis does not change when selecting Report abundance as Volume.

The gray line represents the EIC of the selected ions across the entire 
retention time range, the magenta colored line represents the elution profile of 
the feature as determined by MFE.

When you click within any chromatogram you can zoom in on the axes of the 
entire data set to see more of the feature detail. You can click on the zoom out 
and y-axis scale buttons to further adjust the zoom factor on all of the 
chromatograms.
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Spectra pane
This information is not available for CEF and CSV file types.

The spectra pane shows the averaged raw centroid mass spectra across the 
common elution time range for the selected feature in all samples. The ions 
associated for the selected feature in each sample is marked by a red dot. The 
y-position of the red dot corresponds to the abundance of that ion in the 
species table if Report abundance as is set to Volume. The absolute height of 
the signals in the spectrum is arbitrarily scaled so they are slightly higher than 
the indicating dot. However, the relative difference of signals within a 
spectrum, or between spectra of the different samples, is maintained.

When you click within any spectrum you can zoom in on the axes of the entire 
data set to see more of the feature detail. You can click on the zoom out and 
y-axis scale buttons to further adjust the zoom factor on all of the spectra.

Feature Details shortcut actions
See “Feature Details shortcut menu” on page 42 for options when you 
right-click within a chromatogram or spectrum.

Shortcut menu commands
Shortcut menus provide options (Figure 8 on page 40) applicable to the 
context where you click and to your current view. The following shortcut 
menus are presented:

• “Feature Table shortcut menu” on page 40

• “Feature Plot shortcut menu” on page 41

• “Feature Details shortcut menu” on page 42
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Figure 8 Shortcut menu commands available within the main window 

Feature Table shortcut menu
Available when you right-click along the left-most row column in the Feature 
Table. The shortcut menu is shown in Figure 8 on page 40.

Feature Details Opens the FeatureDetailFrame window in which you can 
review the feature details by sample and by ion, the extracted ion 
chromatogram, and the mass spectrum for the feature as it appears in each 
sample file if the Feature Plot is currently shown in the lower part of the main 
window. If the Feature Details are shown in the lower part of the window, the 
information is updated with the data from the selected feature.

Abundance Distribution Opens the Abundance Distribution of Feature # 
window and displays the abundance profile of the feature and a histogram of 
abundances for the feature within each group.

Identification Lookup Opens ID Browser with the selected feature for 
identification.

Web Mass Search Opens your default Internet browser and performs a web 
search for the selected feature to propose an identification based on the 
feature mass. The available web search options are ChemIDplus, HMP (Human 
Metabolite Project), NIST, PubChem, and Web METLIN.

Feature PlotFeature Table

Feature Details
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Feature Plot shortcut menu
The menu commands available when you right-click in the Feature Plot change 
with whether your pointer is inside the graph region or along the plot border 
containing the axes and plot title. The shortcut menus are shown in Figure 8 
on page 40.

Unzoom Restores the previous zoom level of the Feature Plot.

Autoscale Resets the axes of the Feature Plot to show all of the features.

Print Image Prints the current Feature Plot image based on your current 
printer settings.

Copy Image to Clipboard Copies the current Feature Plot image to the 
Clipboard to paste into other applications as either an Enhanced Meta file (a 
group of objects that form the image) or a Bitmap format (a single image 
object).

Save Image to File Saves the current Feature Plot image as either an 
Enhanced Meta file (.emf) or Bitmap (.bmp) format.

Feature Details Opens the FeatureDetailFrame window in which you can 
review the feature details by sample and by ion, the extracted ion 
chromatogram, and the mass spectrum for the feature as it appears in each 
sample file.

Abundance Distribution Opens the Abundance Distribution of Feature # 
window and displays the abundance profile of the feature and a histogram of 
abundances for the feature within each group.

Identification Lookup Opens ID Browser with the selected feature for 
identification.

Web Mass Search Opens your default Internet browser and performs a web 
search for the selected feature to propose an identification based on the 
feature mass. The available web search options are ChemIDplus, HMP (Human 
Metabolite Project), NIST, PubChem, and Web METLIN.
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Feature Details shortcut menu
If available for the imported file type in your project, menu commands are 
only available when you right-click in the extracted ion chromatogram or 
spectrum plots. The shortcut menus are shown in Figure 8 on page 40.

Print Image Prints the current Feature Plot image based on your current 
printer settings.

Copy Image to Clipboard Copies the current Feature Plot image to the 
Clipboard to paste into other applications as either an Enhanced Meta file (a 
group of objects that form the image) or a Bitmap format (a single image 
object).

Save Image to File Saves the current Feature Plot image as either an 
Enhanced Meta file (.emf) or Bitmap (.bmp) format.
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Unsaved parameter changes
When you make a change to your method in Mass Profiler, the software 
automatically places an asterisk “*” after the method name in the Mass 
Profiler title bar as shown in Figure 9 on page 43. The asterisk indication helps 
you remember that the changes you have made to the method have not been 
saved to a method file on disk.

Methods are saved as follows:

1 You can save the method parameters as an .mpm file. Saving a method 
file is optional.

2 Method parameters used to process or reprocess a project are 
automatically saved when you save the project. The method parameters 
are embedded with the project. When a project is reloaded the 
parameters used to obtain the saved results are loaded into memory and 
the method name is the name of the project, without an asterisk.

3 When you exit Mass Profiler the current method parameters are 
automatically saved internally and reloaded the next time Mass Profiler 
is launched, regardless of whether the method parameters are changed 
or unchanged.

Figure 9 Indication of unsaved changes in your method is by the appearance of an as-
terisk in the title bar.
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Mass Profiler Installation
1 Install Mass Profiler on the highest performing computer you have available 

to reduce the time it takes to extract and view the features in your sample 
files. Mass Profiler requires a computer running Windows 7 (64-bit) with at 
least 8GB of RAM.

Note: For better processing performance choose a higher frequency CPU 
over a larger number of cores. A solid-state hard drive can improve 
performance specifically when extracting features on multiple data files. 
Depending on the size of a project, and the number of features extracted 
per data file, additional RAM reduces processing time by minimizing the 
use of the page file used during the process.

2 If an earlier version of Mass Profiler is already installed on your computer, 
remove the earlier version of the software before installing Mass Profiler 
B.07.00.

3 Refer to the README file that can be found on the installation disc for 
additional information.
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